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Quick Start Guide | Using PFx on an i.MX6 SabreLite

Introduction

This guide is intended to take the user through the steps needed to run PFx tests on a 1.MX6
SabreLite board. PFx is short for all our Processor-based test products as detailed in the below

section.

Software Setup

The computer needs one of the following products installed and licensed depending on the action
desired:

e ScanWorks® Processor-based Fast Programming for ARM 32-bit Processors
e ScanWorks® Processor-based Functional Test for ARM 32-bit Processors
e ScanWorks® Processor-based Functional Test DDR for ARM 32-bit Processors

Hardware Setup

A computer is connected to a hub or switch via an Ethernet cable. A ScanWorks Remote
Instrumentation Controller (RIC-1000) is connected to the hub or switch via an Ethernet cable.
The Ethernet port on the SabreLite is connected to the hub or switch via an Ethernet cable. The
RIC-1000 is connected to the SabreLite’s JTAG port via a RIC-1000 UUT cable and an adapter
for the .M X6 JTAG port.

1.
2.

SourcePoint

Platform for Software Debug and Trace

Start ScanWorks.
Click on the Import Button.
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Projects Status  Notes

@ £ Import | & Proects [EREERTTN

Manage

se Check Out ***
aut: PFPT_ARM_ML_SUB

C A_DLsUB
Checked out: PFT_32ARM_DLSUB
Checked out: PFT_DDR_32ARM_DLSUB

Recent Projects
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& Licenses | ?Help [(ClE
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Quick Start Guide | Using PFx on an i.MX6 SabreLite

3. Click on Browse and browse to the file to be imported —
C:\ScanWorks\Examples\PFx\SabreLite Example Project.zip and click on Open.
A ScanWorks: _— - S S - - @ l': =) g‘
Import a Project m © Back
1. select the Import
File
Import File Browse
Select a compressed ScanWorks Project
Next
L ]|
'm Open

)

@Q‘“ » Computer » Windows (C:) » Scanworks » Examples » PFx »

11

~*L. Documents
. Music

J= Pictures

=. Subversion
i Videos

& Computer
& Windows (C)
% HP_RECOVERY (D ~ ¢ |

File name:

v‘ +4 | | Search PFx o
Organize ~ New folder = - O 9
M Deskiop “ Name : Date modified Type Size
” zecen-t e |_H saBRElite_Example_Projectzip 5/8/2018 920 AM  zip Archive 2578 k8|
= sopre | Zedboard_Example_Projectzip 4/5/2018 10:58 AM  zip Archive 4,960 KB
. Libraries

I | »

SABRElite_Example_Project.zip

hd {ScanWorks Project (*.zip)

)

[ Open Hl Cancel ]
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Click on the Next Button.

& ScanWorks

Import a Project

2. Specify Name 3.Im

Import As  SABREIlite_Example_Project]
Forbidden Characters: / 2\ *:|" > <.
Link Import to Source  [J Notify when project source changes

Destination Directory ~ C:\ScanWorks\Projects Browse

I
|
(—
Click on either Import Button.
[ ScanWorks - . - =) (=] 5 |

Import a Project

C\Scanworks\Examples\PFx\SABRElite_Example_Project.zip
Project Name will be SABRElite_Example_Project

Link to Source? false

Import to C:\ScanWorks\Projects

Ready to import

m
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Click on No Hardware to select the hardware controller.

& ScanWorks: SABRElite_Example_Project.SABRElite

] [ B

Action Name

Search: Find Actions

-

e
Project: SABRElite_Example_Project No Hardware T, Options
Design: SABRElite
Projects Designs Actions Sequences Status Notes Mappings Reports
# Manage % Build ~  Project SABRElite_Example_Project loaded

Loading SABRElite. Please wait.
Loading of design SABRElite complete
Loading of design SABRElite complete

Type

m DDR RAM Test
m Device Presence Tests

m Ethernet Loopback Tests

m Program MMC via Ethernet

m Program MMC via JTAG

m Program SPI Flash via Ethernet

m Program SPI Flash via JTAG

Processor Functional Test
DDR

Processor Functional Test
Processor Functional Test

Processor Fast

Programming

Processor Fast

Programming
Processor Fast
Programming
Processor Fast

Proarammina

& licenses | ?Help (€)=

ScanWorks®

7.

Select RIC-1000 as the controller.

& ScanWorks: SABRElite_Example_Project.SABRElite

] [ (B |

Action Name

Search: Find Actions

-

.
Project: SABRElite_Example_Project No Hardware T, Options
Design: SABRElite
Select a Controller
Projects Designs Actions Sequences i Mappings Reports
No Hardware a
{ -
/& Manage %% Build | Q rimple_iject\oaded

|lease wait.

I m DDR RAM Test
m Device Presence Tests

m Ethernet Loopback Tests

m Program MMC via Ethernet

m Program MMC via JTAG

m Program SPI Flash via Ethernet

m Program SPI Flash via JTAG

PCI-200E)
IBRElite complete
PCL-410 IBRElite complete
PCle-410
Type PCle-1000
Processor Functional Test | PXI-1000

DDR

RIC-1000

RIC-1000PODII

Processor Functional Test

Processor Functional Test -
RIC-4000

Processor Fast
Programming
Processor Fast
Programming
Processor Fast
Programming
Processor Fast

Proarammina

& licenses | ?Help |[©

ScanWorks®
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Configure the RIC-1000’s ip address, and select a TCK Frequency of 30 MHz. Note

that flash programming performance over JTAG is directly affected by the TCK
frequency. The higher the TCK Frequency, the better the programming performance.

-

Setup Hardware

-

Setup RIC-1000 Hardware K

| TCK Freguency (MHz): Delay Compensation: Cancel
|30.000 hd l Iu :I
Help
TAP Voltage: IP Address:
|3.3 - l 1592.168.12.119)

Discrete 10 TAP Voltages

Discrete 10 Signal 0 and 1:
|3.3 - l

Dizcete 10 Signal 2 and 3:
I 33 i l

Dizcrete 10 Signal 4 and 5:
I 33 i I

Discrete 10 Signal & and 7:
I 33 - l

aaal

Click OK.
9.

Now let’s run the DDR RAM Test Action from within Edit mode.

& ScanWorks: SABREI|te,B(ampIe,PmJect.S/iBRE]|te . {to J =|E ﬁ
- . - = Options | f Licenses | ?Help [G1E4 ‘
Project: SABRElite_Example_Project # RIC-1000 E L=
Design: SABRElite TCK Frequency: 30.000 MHz
IP Address: 192.168.12.119
Compatible with Design? ves
Projects Designs Actions Sequences Status Notes Mappings Reports
£ Manage | %€ Build Project SABRElite_Example_Project loaded
Loading SABRElite. Please wait...
Loading of design SABRElite complete
Search: Find Actions Loading of design SABRElite complete
Loading of design SABRElite complete
Action Name *  Type
m DDR RAM Test Processor Functional Test
DDR
m Device Presence Tests Processor Functional Test
l m Ethernet Loopback Tests Processor Functional Test
m Program MMC via Ethernet Processor Fast
Programming
N m Program MMC via JTAG Processor Fast
Ml Programming
i P Fast
m Program SPI Flash via Ethernet rocessortas
I\ Programming
P Fast
m Program SPI Flash via JTAG focessortas .
Proarammina
ScanWorks*
| m———
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Quick Start Guide | Using PFx on an i.MX6 SabreLite

10. Right Click on DDR RAM Test.

This will launch the Development interface.

@ VTOS Developer™ [3.0.14.7] (DDR RAM Test)

o] =]E

Project: C:\ScanWorks\Projects\SABRElite_Example_Project\SABREIite\DDR RAM Test\DDR RAM Test\DDR RAM Test.project (i.MX6 iMX6Q) [VTOS DDR]

File | Tools View Licensing Help
[Craa ) Ccomea | ‘
Welcome! NECT  DDR TFTP
FProject Settings | console
[ Project:DDR RAM Test N caners]
B @ Connection Settings Name DDR RAM Test
O Foaure:(1] e
® <Add Fixure> v
5% Tasks Stop On Failure True
2] Task-VTOS DDR Normalize Files True
® <Add Task> 4 Target
Load Firmware on Connect False
Issue Target Version False
Issue Reset on Disconnect False
4 VTOS Runner
Task Logging Option Append
S % Configuration [VTOS DDR] A Use Timestamps False
EH e Boar Run Option Stop on Failure
[ Board nitalization Run Delay (ms) o
5 Scripts Loop O
3 Processor [iMX6Q] Loop Option oop Once
)4 DDR Setings Loop Stop Condition 1
Board Specifc
m DDR3Memory Part:micron_ddi3_MT41.128M16-15E ks
£ @ DDR Tune
DDR3 PHY Calibration
@ Read)Wiite Latency Calibration
£ [5) DDR Interactive Tests
DDR Walking 0 Test
DDR Walking 1 Test =
DDR Address Te:
DDR Simuitaneously Switching Output Test
DDR Noise Burst Test o
DDR Noise Test
DOR Pl B Test Name of the selected item
DDR Full Byte Test
DDR Full Word Test
DDR Structural Test
DDR Noise Group Test
DDR Comprehensive Test
DDR Constrained Random Test
& DDR Performance Test
£ [5) DDR Exported Tests
& DDR Comprehensive Test o
[ copy J[ peete |[ up ][ pown |

Elapsed: 00 00:000

11.
begin communicating with the target agent.

Click on the Connect Button. This will download a target agent to the SabreLite and

@ VTOS Developer™ [3.0.14.7] (DDR RAM Test)

=] el E

File | Tools View Licensing

Help

[ e s

Connected [VTOS DDR, iMX6 . MX6Q, SCANWORKS]
Project Settings | Console
& [7] Project:DDR RAM Test
=& Connection Setings
3 Fidure:{1]
® <Add Fixture>
2% Tasks
) Task VTOS DDR
@ <Add Task>

DDR Firmware
03.084 (2018.05)
at 14:15:11

Task
=% Configuration [VTOS DDR] -

oar
[ Board Initilization

i Scipts

£+ Processor [iIMX6Q]
=48 DDR Setings

Board Specific IMX6

m DDR3 Memory Part:micron_ddr3_MT41J128M16-15E ksc

DDR3 PHY Calibration
~® Read)Write Latency Calibration
=2 DDR Interactive Tests

DDR Simultaneously Switching Output Test
DDR Noise Burst Test

DDR Noise Test

DDR Full Burst Test

DDR Gomprehensive Test
DDR Constrained Random Test
DDR Performance Test
=[] DDR Exported Tests
© DDR Comprehensive Test <

[ copy J[ peete |[ up ][ pown |

Project: C:\ScanWorks\Projects\SABREIlite_Example_Project\SABREIite\DDR RAM Test\DDR RAM Test\DDR RAM Testproject (i.MX6 iMX6Q) [VTOS DDR]

CONNECT  DDR TFTP

Elapsed: 00 93:602

Platform for Software Debug and T
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Quick Start Guide | Using PFx on an i.MX6 SabreLite

12.  You can manually run any of the tests in the DDR Interactive Tests group or the DDR
Tune Task by right clicking on it and selecting Run. Click on the Run Button near the
top of the window to run the test(s) that are in the DDR Exported Tests group.

(=] | e

&

@ VTOS Developer™ [3.0.14.7] (DDR RAM Test)

Help

File Tools View Licensing

Disconnect

“ Add | Run

CONNECT ~ DDR TFTP

Done

Project
&[] ProjectDDR RAM Test
£1 @ Connection Settings
|03 Fixture:{1]
® <Add Fixture>
5% Tasks
(] Task:-VTOSDDR
® <Add Task>

Task

=T Configuration [VTOS DDR]
Erle Boar
[0 Board nitialization

4 Scripts
1 Processor [MXEQ]
583 Seftings

Board Specific MX6
=3 DDR3 Memory Part micron_ddr3_MT41J128M16-15E ksc
DDR Tune
@ DDR3 PHY Calibration
@ Read)Wiite Latency Calibration
£1[2] DDR Interactive Tests
® DDR Walking 0 Test

5 DDR Walking 1 Test

5 DDR Address Test

5 DDR Simultaneously Switching Output Test

£+ DDR Exported Tests
@ DDR Comprehensive Test

[ copy |[ petete |[ up ][ Down |

Project: C:\ScanWorks\Projects\SABRElite_Example_Project\SABREIite\DDR RAM Test\DDR RAM Test\DDR RAM Testproject (iMX6 i MX6Q)

Settings | Console

Sddr. LAONED // ddr_tAONED

$ddr. CAOFED // ddr_tAOFED

$ddr.tWLO // ddr_tWLO
160000 -> $adr.tREC // ddr_tREC
7600000 -> $adr.tREFT // ddr_tREFT

> sadr.rows // ddr_ro

$aar.colums // dar_column

$adr.banks // ddr_banks
0 -> $adr.bank groups // ddr_bank groups
1 sddr.width // ddr_width
aar. timing. convert

adr. configure

Single channel DDR detected

Configuring MIDC chamnel 1 for DIR3
ting MUDC channe

znammg %o 1 controlier for DDR3

[00000000_10000000]
[00000000_10000000]
[00000000_10000000 - 00000000_4£EEEEEE]
Simult switch (64-bit) [00000000_10000000 - 00000000_ALEEfrre]
noise [00000000_10000000]
8 bit) [00000000_10000000 - 00000000_100£EEEE]
bit) [00000000_10000000 - 00000000_100FEEES]
4 bit) [00000000_10000000 - 00000000_4LEEEEEE]
(barst) [00000000_10000000 ~ 00000000 seececee]
0 Failed, 0 Aborted, Running time

) [VTOS DDR]

13. Add a test to the DDR Exported Tests group by right clicking on <Add Test> beneath
DDR Comprehensive Test. Select DDR Performance Test from the list of tests. Then
hit File->Save to save the updated project. Hit the Run button at the top of the interface.

= ol E e

@ VTOS Developer™ [3.0.14.7] (DDR RAM Test)

Help

File Tools View Licensing

Disconnect

CONNECT  DDR TFIP

“ add | Run

Done

Project
=-[7] Project:DDR RAM Test
£1 3@ Connection Settings
| o Fixture{1]
® <Add Fixture>
5% Tasks
(] Task:-VTOSDDR
® <Add Task>

Board
[0 Board nitialization
&5 Scipts
= Processor [IMX6Q]
=+ DDR Setings
Board Specific IMX6
= DDR3 Memory Part:micron_ddi3_MT41J128M16-15E ksc
DDR Tune
® DDR3PHY Calbration

® DDR Performance Test - Access Time

D oA Tocen

Copy |[ petete |[ up || Down

Project: C:\ScanWorks\Projects\SABRElite_Example_Project\SABREIite\DDR RAM Test\DDR RAM Test\DDR RAM Testproject (iMX6 i MX6Q)

Settings | Console
7800000 -> Scar. tREFL // ddr_tREFL

14 -> $ddr.rows // ddr_rows
$aar.colums // dar_column
-> $adr.banks // adr_bank:
. groups // adr_bank grom
> §dar.width // adr_width
dar . timing. convert

adr . configure
Il s:7o1c channe1 poR cetectea
ing MUDC channel 1 for DDR3

mum Memory Co
Walking 0
Walking 1
) [00000000_10000000 - 00000000_4f££EEEE]
[nnnnnnnn 100000001
[00000000_10000000 ~ 00000000_100£££EE]
£ bit) [00000000_10000000 — 00000000 100E£EEf]
D b 4 bit) [00000000_10000000 - 00000000 AfffEfff
(burst)
ed, 0 Failed, 0 Aborted, Rumning time

rornance // DDR Perfornance Test - Access Time
it) [00000000_10000000 - 00000000_100£EEEE]
0.000 000 007, throughput — 471.113 MiB/s
cache write (82-B1%) [00000000_10000000 - 00000000 100£EE£E)
= 0.000 000 002, throughput — 1098.352 MiB/s
Running time 1.756

) [VTOS DDR]

)_3 1
[00000000_10000000 - 000DODO0_AEEEEEEE]
14.441 seos

Platform for Software Debug and Trace
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Quick Start Guide | Using PFx on an i.MX6 SabreLite

14. Close the Development window, and return to the ScanWorks Actions view. Click on
the Run Button to the left of DDR RAM Test to run the DDR Exported Tests as a

ScanWorks Action.

m DDR RAM Test

# Edit ] Copy

» Run >_ Rename
Q Delete

(1l Reports

= Requirements

m Device Presence Tests
m Ethernet Loopback Tests

m Program MMC via Ethernet

m Program MMC via JTAG

\m——]

Processor Functional Test
DDR

Processor Functional Test
Processor Functional Test
Processor Fast
Programming

Processor Fast

Praarammina

SDRAM: cache write (32-bit) [00000000_10000000 - 00000000_100FfFff]
WRITES: average seek

©.600 800 802, throughput = 1898.011 MiB/s

Test Suite Totals: 2 Passed, @ Failed, @ Aborted, Running time 1.592

secs

> @:108 | resp-'’

-> Test passed; status=100
Done.
Done!

Action passed!

P

Run time: 27.866

ScanWorks®

= -— - =
A ScanWorks: SABRElite_Example_Project.SABRElite E s | (5] g
. . . = i i ?
Project: SABRElite_Example_Project # RIC-1000 Sepis | Stemes | FGER ‘
Design: SABRElite TCK Frequency: 30.000 MHz
IP Address: 192.168.12.119
Compatible with Design? ves
Projects Designs Actions Sequences Status Notes Mappings Reports Pa Sse d
& Menage | #8Build -> @:108 | resp=' N
-» Test passed; status=100
test.ddr.performance // DDR Performance Test - Access Time
Search: Find Actions SDRAM Performance Suite
SDRAM: cache read (32-bit) [@0@000_10000000 - BOEEEGEE_10GFf{ff]
Action Name Type READS : average seek = 0.600 @00 007, throughput = 478.298 MiB/s

15.
Presence Tests.

Right Click on Device Presence Tests to enter the Development interface for the Device

@ VTOS Developer™ [3.0.145] (Device Presence Tests)

——— o ol ]
File Tools View Licensing Help
‘ Add Connect Run Disconnect

‘Welmme!

CONNECT PIN TP |

fProject

< Ethemet Group
Eb= PHYs

® Ethemet PHY Exists Test

@ Ethemet PHY Verify Test

@ <Add Test>
GPIO Group
~ GPIOT
~ GRIO2
~ GPIO3
~ GPIO4
~ GPIOS
~ GPIOB
~ GPIO7
< 12C Group
B 2C1

]

ice Exists Test

Sefttings | Console
=[] Project:Device Presence Tests 4 General
&) Connection Setings Name Device Presence Tests
S s
% T Stop On Failure True
) Task VTOS Scan Plus Normalize Files True
@ <Add Task> “ Target
Load Firmware on Connect False
Issue Target Version False
Issue Reset on Disconnect False
4 VTOS Runner
I Task Logging Option Append
=% Configuration [VT0S Scan Plus] A Use Timestamps False
. = Run Option Stop on Failure
| [ Board hitalization Run Delay (ms) o
E. ;‘C"”g“’s"“g““"“" Loop Option Loop Onee
14 Processor [IMX6Q] Loop Stop Condition
[ Bluetooth Group (UART) j
~ UART2
I ~ UART3
- UART4

Name
Name of the selected item

Project: CASc j BRElite_Example_Project

Device Presence Tests\Device Presence Tests\Device Presence Testsproject (iMX6 i.MX6Q) [VTOS Scan Plus 3

SourcePoint’

Platform for Software Debug and Trace
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Quick Start Guide | Using PFx on an i.MX6 SabreLite

16. This action checks for the presence of the Ethernet Phy, the flash device on the SPI
port, the device on the 12C bus, and the presence of the MMC device. Hit the Connect
button, then the Run button.

@ VT0S Developer™ [3.0.14.5] (Device Presence Tests)

=] 1o]E

File | Tools View Licensing

‘\ add | Run || Disconnect

Help

Done
Project

- [7] Project Device Presence Tests
& Connection Settings
| O Fixure{1]
® <Add Fiure>
2% Tasks
2! TaskVTOS Scan Plus
@ <Add Task>

Task
5% Configuration [VTOS Scan Plus]

[ Board Initilization
[ Pin Configuration
& Scipts
& Processor [iIMX6Q]
E< Bluetooth Group (UART)
1l

~ UART2
~ UART3
~ UART4
~ UARTS
£ Ethemet Group

s
thernet PHY Exists Test
thernet PHY Verify Test
<Add Test>

=< GPIO Group

=~ GPIO1

~ GPIO2

~ GPIO3

- GPIO4

~ GPIO5

~ GPIOB

- GPIO7

12C Group

C Device Exists Test

[ copy J[ peete |[ up ][ Down |
| S [ Dee J| P | Down

o t // 12C Verify Test(0, 0x14)

= . st // SD/MMC Device

Project: C:\ScanWorks\Projects\SABRElite_Example_Project\SABREIite\Device Presence Tests\Device Presence Tests\Device Presence Tests.project (iMX6 iMX6Q) [VTOS Scan Plus B S N NI

CONNECT PIN TFTP

Settings| Console

22 PHY ID Low=0x1611

22 PHY ID Low=0x1611

0 0x14 8 0x00000000 & 0x00000000 0 12

%00 data=0xa0

x00 data=0xa0

ammc.width.set // SDMMC Set Bus Width ( , widtn=1)

verify-FALSE)

x00772000 TRUE sdmmc.verify.test // SD/MMC Verify Test (channel=3, manufacturer-id=0x19, oem-
e Verify Test
—3 Manufacturer ID-0x19 OEM ID-0x4459

rial_flash.verify.test // SPI Flash Device B est (0, 1, 1000000, -1,

©
d Data=0xBF 0x25 0x41

ify.test // SPI Flash Verify

17. If the SD/MMC Verify test fails, the most likely cause is the SD/MMC card in your
SabreLite is a different make/model than the one used when creating this guide. To
update the settings for your SD Card, click on SD/MMC Verify test and then change
the Manufacturer ID, OEM ID and size fields to match your SD card. Note that the size
of the SD/MMC card is printed out in decimal in the test, but the input field is
expecting a hexadecimal entry. Save the Project. Hit the Run button to verify the
change in settings have corrected the problem.

@ VTOS Developer™ [3.0.14.5] (Device Presence Tests)

=) =lE

File | Tools View Licensing

= Fp— r—

Done

Project

= Project Device Presence Tests
& @ Comneciion Setings
[0 Fidure:[1]
® <Add Fixture>
= Tasks
£/ Task:VTOS Scan Plus
® <Add Task>

-/ NOR Flash Group
Chip Selectd
Chip Select 1
~ Chip Select2
~ Chip Select3
£/ SDMMC/SDIO Group
i~ uSDHC

© SD/MMC Device Exists Test
© SD/MMC Veriy Test

©® <Add Test

< SPIGroup
= SPit

® SPIFlash Device Exists Test
© SPIFlash Veriy Test

® <Add Test

@
2

- SPl5
E€ UART Group

Copy. Delete Up || Down

Help

CONNECT PN TFTP

Settings | Console|

Setup Actions <Add Actions>
Cleanup Actions <Add Adtions>
4 specific

Manufacturer I 019
OFM Id oxats |
Capacity 0x00772000

Manufacturer Id
The 8-bit expected manufacturer ID returned by the SD/MMC device in the Card Identification register (CID).

Project: . Example_Projec

Device Presence Tests\Device Presence Tests\Device Presence Testsproject (.MX6 iMX6Q) [VTOS Scan Plus| SRR N R

Platform for Software Debug and Trace

O ScanWorks®
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Quick Start Guide | Using PFx on an i.MX6 SabreLite

18. Close the Development window, and return to the ScanWorks Actions view. Click on

the Run Button to the left of Device Presence Tests to run the Device Presence Tests as
a ScanWorks Action.

- = ——
A ScanWorks: SABRElite_Example_Project.SABREIite

==

Design: SABRElite

Projects Designs

Action Name

Actions

#Manage & Build

Project: SABRElite_Example_Project

Sequences

Search: Find Actions

- Type

(B oor R Test
m Device Presence Tests

FEdit  (1Copy

» Run >_ Rename
© Delete

[al Reports

= Requirements

m Ethernet Loopback Tests

m Program MMC via Ethernet

Processor Functional Test
DDR

Processor Functional Test

Processor Functional Test

Processor Fast

Programming

Processor Fast

£ RIC-1000 I:Options | & Licer
TCK Frequency: 30.000 MHz
IP Address: 192.168.12.119
Compatible with Design? ves
Status Notes Mappings Reports
ash Device Exists Test (0, 1, 1000000, -1, -1)

SPI Serial Flash Device Exists Test

SPI:

> @:108 | resp-'’
-> Test passed; status=100
© 1 1000000 -1 -1 @XBF 9x25 @x41 True spi.serial_flasl
/1 SPI Flash Verify Test (8, 1, @xBF, 8x25, 0x41)
SPT Serial Flash Verify Test
SPI: channel=0 chip select=1 Read Data=8xBF @x25 @x41
> 0:108 | resp-'’
-> Test passed; status=10@
Done.
Done!

Action passed!

channel=e chip select=1 Read Data=exBF ©x25 @x4l

nses | 2Help [(C1= 14

h.verify. test

Fr—

Run time: 13.268

ScanWorks*

19. Right click on the Ethernet Loopback Tests action to open the Development interface
for the Ethernet Loopback Tests.

@ VTOS Developer™ [30.147] (Ethernet Loopback Tests)

=

File Tools View Licensing

Help

Run Disconnect

‘ Add Connedt

‘ Welcome!

CONNECT PIN

TR | ‘

FProject

Settings | Console

Project Ethemet Loopback Tests
Connection Setings
'O Firture:{1]
® <Add Fiure>
% Tasks
2! TaskVTOS Scan Ethemet
@ <Add Task>

Task

% Configuration [VTOS Scan Ethernet]
1 Board
[ Board Initilization
[ Pin Configuration
Scripts
Processor [LMX6Q]
< Ethemet Group

s
® Ethemet PHY Exists Test:Phy?
@ Ethemet PHY Verify Test

® <Add Test>

® EthemetMAC Loopback Test:10 Mbps
® Ethemet MAC Loopback Test:100 Mbps
® Ethemet MAC Loopback Test:1000 Mbps
® EthemetPHY Loopback Test- 10Mbps
® Ethemet PHY Loopback Test- 100 Mbps
@ EthemetPHY Loopback Test- 1000 Mbps
® <Add Test>

Name of the selected item

4 General
Name Ethernet Loopback Tests
Processor M6 iMXEQ
Stop On Failure True
Normalize Files True

4 Target
Load Firmware on Connect False
Issue Target Version False
Issue Reset on Disconnect False

4 VTOS Runner
Logging Option Append
Use Timestamps False
Run Option Stop on Failure
Run Delay (ms) [
Loop Option Loop Once
Loop Stop Condition 1

Name

Down

- Example_Project

Loopback Tests\Ethernet Loopback

Loopback Tests.project (iMX6 iMX6Q) [VTOS St

SourcePoint’

Platform for Software Debug and Trace
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Quick Start Guide | Using PFx on an i.MX6 SabreLite

20. This action tests for the presence of the Ethernet Phy, does loopback tests on the
ethernet MAC and loopback tests on the Ethernet Phy. Click on Connect and then on
Run.

@ V105 Developer™ [3.0.14.7] (Ethernet Loopback Tests) o] b B s

File Tools View Licensing Help

[ [ coves [ ma [ oscomea | ‘

Done CONNECT PIN TFTP

Project Settings | Console
=[] Project Ethemet Loopback Tests
(& Connection Setings 0 0 7 enct.phy.set.ext // Set PHY (ethernet_i
| O Fixure{1] -
® <Add Fidure> .LB.MAC . " t // Ethermet MAC Loopl
5% Tasks erne copback
[ TaskVTOS Scan Ethemet © al interface (PHYT) )
& <ado Tasko opback folly, ed packet count 64

Task
5% Configuration [VTOS Scan Ethemet]

[ Board nitislization

[ Pin Configuration

Scripts

Processor [iMX60]

< Ethemet Group
- P

Ethemet PHY Exists TestPhy7
© Ethemet PHY Verify Test

® <Add Test> K cte eceived packet count 64
B ENET
Ethemet MAG Loopback Test:10 Mbps
Ethemet MAC Loopback Test:100 Mbps .LB.PHY enet. loopbac) // Ethernet PHY Loopback Test - 100 M
Ethemet MAC Loopback Test:1000 Mbps erne HY loopback, 100
Ethemet PHY Loopback Test- 10 Mbps e al interface (P!
Ethemet PHY Loopback Test- 100 Mbps
Ethemet PHY Loopback Test- 1000 Mbps
<Add Test>

Copy pelete |[ up || Down |

Project: C:\ScanWorks\Projects\SABRElite_Example_Project\SABRElite\Ethemet Loopback Tests\Ethernet Loopback Tests\Ethemet Loopback Tests.project (iMX6iMX6Q) [VTOS (BN N S

21. Close the Development window, and return to the ScanWorks Actions view. Click on
the Run Button to the left of Ethernet Loopback Tests to run the Ethernet Loopback
Tests as a ScanWorks Action.

A8 ScanWorks: SABRElite_Example_Project SABRElite (2] [=]2 s

. < . . S — ? He
Project: SABRElite_Example_Project £ RIC-1000 Options | & Licenses || ? Help

Design: SABRElite TCK Frequency: 30.000 MHz
IP Address: 192.168.12.119

Compatible with Design? ves
Projects Designs Actions Sequences Status Notes Mappings Reports Ssed

| #Manage % Build -
> 0:100 | resp-'"

-> Test passed;

Search: © #ENET.LB.PHY 1 enet.loopback.test // Ethernet PHY Loop

back Test - 1000 Mbps(0, 1000, 64)

Action Name “  Type Ethernet Packet Test: PHY loopback, 1000 Mbps
fece: initializing physical interface (PHV7)
Processor Functional Test
m DDR RAM Test Link is up on PHY7
DDR _— .
Loopback test completed successfully, received packet count
m Device Presence Tests Processor Functional Test

@0 | resp=""

m Ethernet Loopback Tests

# Edit ¢ Copy

-> Test passed; status=100

Done.
>. .
> Run =L Processor Functional Test Done!
© Delete . 0
Action passed
[l Reports

= Requirements

- Processor Fast ime:
m Program MMC via Ethernet i fun time: 15.308
Programming
- >

ScanWorks'

— o Processor Fast

ScanWorks’
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Quick Start Guide | Using PFx on an i.MX6 SabreLite

22. Right click on Program MMC via Ethernet to open Development interface for the
Program MMC via Ethernet action. This action tests to see if the MMC is unprotected,
erases the MMC, does a blank check on the MMC, programs the MMC with a test file
over Ethernet, and then tests the checksum of the range of MMC memory that was
programmed.

@ VTOS Developer™ [3.0.14.5] (Program MMC via Ethernet) . =)

File Tools View Licensing

Help

Welcome! CONNECT PIN TFTP FLASH

Project] Settings | Console

=[] Project:Program MMC via Ethemet

4 General
(78 Connection Setings Name Program MMC via Ethernet
i 8 :‘J;Fgm) Processor iMX6 iMX6Q
5% Tasks Stop On Failure True
-2 Task:VTOS Program MMC Ethemet Normalize Files True
® <Add Task> 4 Target
Load Firmware on Connect False
Issue Target Version False
Issue Resat on Disconnect False
4 VTOS Runner
Task Logging Option Append
u Fal
% Configuration [VTOS Program MMC Ethemet] =e e
= Run Option Stop on Failure
[ Board Initialization Run Delay (ms) 0
Pin Configuration Loop Cption Loop Once
cripts
ocessor [ MX6a] Loop Stop Condition 1
SD/MMC Group
~ uSDHC1
~ uSDHC2
~ uSDHC3
(= uSDHC4

® SD/MMC:SDMMC 4:1
® <Add Device>
15 TFTP Server
=& Program Operations
® Image Unprotected Test
@ Image Erase Test
@ Image Blank Test -
@ Program From File Using TFTP Name of the selected item
@ Image Checksum Test
@ <Add Operation>
4 Fuse Operations

o) (oo | e oo ]

Project: C:\ScanWorks\Projects\SABRElite_Example_Project\SABREIite\Program MMC via Ethernet\Program MMC via Ethemnet\Program MMC via Ethemetproject (iMx6 iMx6Q) [ BRI R A
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23. To use the ethernet port on the UUT as the data pipe, the ethernet on the UUT must be
configured, and a TFTP client must be configured. Click on TFTP Server under the
Task tab to configure the UUT’s ipaddress and the TFTP client settings. Clicking on the
pull down to the right side of TFTP Server Address will show a list of available
addresses to use. Use the ipaddress of your computer as the ipaddress of the TFTP
Server.

@ VTOS Developer™ [3.0.14.5] (Program MMC via Ethernet) oo =)

File Tools View Licensing Help
Welcome! CONNECT PIN TFTP FLASH
Project Settings | Console
(=[5 Project:Program MMC via Ethemet 4 General
= cunFnecmnﬂs]emngs Name.
3 Fixture: . .
® <Add Fixture> Actions
£% Tasks Setup Actions <Add Actions>
£ Task:VTOS Program MMC Ethemet Cleanup Actions <Add Actions>
® <Add Task> 4 Specific
Use TFTP File Transfers True
Target Ethernet Controller ENET1
Target MII Type RGMI (Reduced Gigabit MID)
Target PHY Address 7
Task Target MAC Address 00:1E:C3:00:00:00
5% Configuration [VTOS Pragram MMC Ethernet] Target IP Address 102.168.12.101
G Board Subnet Mask 255.255.255.0
[ Board Initializztion TFTP Server IP Address 192.168.12.228 =1
nC‘cnﬁguvahun + Gateway
cripts
oteasor LMXEQ] Use a Gateway False
SD/MMC Group Target Gateway IP Address 10.10.10.1
~ uSDHC1
~ uSDHC2
~ uSDHC3
£~ uSDHC4

® SD/MMC:SDMMG 41
® <Add Device>
1ty TFTP Server
= & Program Operations
Image Unprotected Test
g }mage E\ESETTES: TFTP Server IP Address
mage blank Tes The IP Address for tha computer running the TFTP Server. This could be this computer or ancther network computer. The default list is provided based on IP

® Program From File Using TFTP g
@ Image Checksum Test Addresses for this computer. Invalid values will not be saved.

@ <Add Operation>
® Fuse Operations

[comr ] [Losee ] [up] [oowwn ]

Project: C\ScanWorks\Projects\SABRElite_Example_Project\SABREIite\Program MMC via Ethemet\Program MMC via Ethernet\Program MMC via Ethernetproject (.MX6iMX6Q) [ [FE R I
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24. Now configure the ipaddress of the UUT by entering the desired value in the field to
the right of Target IP Address. The appropriate subnet mask will be calculated and
entered automatically. Save the project.

@ VTOS Developer™ [3.0.14.5] (Program MMC via Ethernet)

= el

File Tools View Licensing Help
|L_xe [ comea ‘
Welcome! CONNECT PIN TFTP FLASH

Project Settings | Console

= [ Project:Program MMC via Ethemet 4 General
B @S)r\;ﬂ;cﬂar\[iemngs Name
ixture: 4 At
| ® <Add Fidure> Actions
L% Taaes Setup Actions <Add Actions>

¥ Task:VTOS Program MMC Ethemet
® <Add Task>

Task
5% Configuration [VTOS Progiam MMC Ethemet]

[ Board Initialization
[ Pin Configuration

Cleanup Actions
4 Specific

<Add Actions>

Use TFTP File Transfers True
Target Ethernet Controller ENET1
Target MII Type RGMI (Redluced Gigabit MI)
Target PHY Address 7

00:1E:C3:00:00:00

Target MAC Address

Subnet Mask
TFTP Server IP Address
4 Gateway

192.168.12.101
255.255.255.0
192.168.12.228

-5 Scripts
=} Processor [iMX6Q]
=+< SDIMMC Group
= uSDHC1

Use a Gateway False
Target Gateway IP Address 10.10.10.1

= uSDHC2
i)~ uSDHC3
£}~ uSDHC4
® SD/MMC:SDMMC 4:1
@® <Add Device>
ol TFTP Server
= & Program Operations
® Image Unprotected Test
) Image Erase Test
) Image Blank Test
® Program From File Using TFTP
@ Image Checksum Test
® <Add Operation>
&4 Fuse Operations

TargetIP Address
The IPv4 Address used by the target circuit board for network communications, using dot notation. Invalid values will not be saved.

[ copy |[ peete |[ up ][ pown |

Project: C:\ScanWorks\Projects\SABRElite_Example_Project\SABREIite\Program MMC via EthernetiProgram MMC via Ethernet\Program MMC via Ethemnetproject (iMX6iMx6Q) [ BRI R

25. Now that the TFTP Server is configured, The TFTP Server needs to be started. From
the top memu bar of the Development interface, Use the Tools pulldown and select
Tools-> Start TFTP Server. Note that the TFTP Server continues to run until it stopped
via Tools->Stop TFTP Server or the computer is shut down. You can tell the TFTP
Server is running when TFTP is shown in green in the upper right hand corner of the
Development Interface.

@ VTOS Developer™ [3.0.145] (Program MMC via Ethernet) =] =l E
File Tools View Licensing Help
“ add ][ comea |

onNecT TP FLas

TFTP Server is running.
Project Settings| Console

=3 Project:Program MMC via Ethemet
£ @ Connection Setings
-3 Fixture:{1)
® <Add Fixture>
Ty Tasks

21 Task:VTOS Program MMC Ethemat
@ <Add Task>

Task
=% Configuraton [VT OS Program MMC Ethemel]
== Board

[ Board Initialization
{3] Pin Coniguration

cripts
- Processor [iMX6Q]
52 s

Group
& = uSDHCT
- uSDHC2

~ uSDHC3

HC4
@ SD/MMC:SDMMC 41
@ <Add Device>
& TFTP Server
# Program Operations
® Image Unprotected Test
® Image Erase Test
® Image Blank Test
® Program From File Using TFTP
® Image Checksum Test
® <Add Operation>
i@ Fuse Operations

oo (o) (v oo

MMC via Ethernetproject (.MX6 iMX6Q) [ B N NI RANI

ScanWorks’

Platform for Embedded Instruments
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Quick Start Guide | Using PFx on an i.MX6 SabreLite

26. Click on Connect and then click on Run.

@ VTOS Developer™ [3.0.14.5] (Program MMC via Ethernet)

S

File Tools View Licensing

Help

Run ‘ ‘ Disconnect

Done

Project Settings| Console
= [7] Project:Program MMC via Ethemet )
£ & Connection Setiings
03 Fiturex[1]
® <Add Fixture>

Task:VTOS Program MMC Ethemet

[PASSED]
0 #ENET.RGMIT 7 s° O

ot Ethernet MAC Addre:
E % Configuration [VTOS Program MMC Ethemet]
= Boai

[ Board Initialization
Pin Configuration

SD/MMC::SDMMG 41
® <Add Device>

ks TFTP Server

Program Operations

@ Image Unprotected Test

@ Image Erase Test

@ Image Blank Test

@ Program From File Using TFTP

@ Image Checksum Test

® <Add Operation>

&4 Fuse Operations

T
E

[PASSED]

[ copy |[ peete |[ up ][ Down |

n B
S Tasks

® <Add Task> 4 sdmmc.width.set // SDMM

DM :1' 3 sdmme.install drop // SD/MMC Install(SDMMC 4:1)

Configure the Ethernet
Task ©

5 Scripts SDMMC 4:1' 0x0000000005000000:64 0x0000000000100000: 64 image6d.anprotected.test // Image Unprotected Test(SDMMC 4:1)
=4 Processor [|MX6Q] ice unprotected/unlocked verify te
E-< SDMMC Group D]
- uSDHC1
B+ uSDHC2 4 0x0000000000100000: 64 image6d.er: // Image Erase T (SDMMC
- uSDHC3
-+ uSDHC4

Project: C:\ScanWorks\Projects\SABRElite_Example_Project\SABREIite\Program MMC via Ethernet\Program MMC via Ethernet\Program MMC via Ethemetproject (.MX6iMx6Q) [ BRI R R

CONNECT PIN TFTP FLASH

xample Project\SABREL1te\Program MMC via Ethernet\Program MIC via Ethernet\

sabrelitd
xample Project\SABRELite\Program M«

via Ethernet\Program MMC via Ethernet\sabrelite

set Bus Width (bt width=4)

00:00:00" ip/1 .12.101 1p/255.255.255.0 .168. ip/10.10.10.1 &£ty
Controller and TFTP Server
to (00:1E

64 0x0000000000100000: 64 image // Image Blank T

\Projects\SABRE11te_Example_ProJject\SABRE1ite\Program MMC via JTAG\Program

xample_Project\SABRELite\Program MIC via JTAG\Program MMC via JTAG\lmb

I

27.

In the example above, the MMC was programmed at a rate of 7 MiB/second. Close the

Developement interface, and click on the Run button to the left of Program MMC via
Ethernet to run the action from ScanWorks.

% ScanWorks: SABRElite_Example_Project.SABRElite

=] (=[O
. c . . tions cens D
Project: SABRElite_Example_Project /& RIC-1000 Options | & Licenses | ? Help
Design: SABRElite TCK Frequency: 30.000 MHz
IP Address: 192.168.12.119
Compatible with Design? ves
Projects Designs Actions Sequences Status Notes Mappings Reports Pa ssed
| #Manage | 2 Buid onds, throughput of 3.446 MiB/s a
-> 0108 | resp="
Search: -> Test passed; status-100
64
Action Name Type 89e66° TRUE image64.mdS.test
m DDR RAM Test Processor Functional Test SUM Verify Test: start offset Gx 9x2000800
DDR
m Device Presence Tests Processor Functional Test "SDMMC 4:1° mdS=aa26ff5b895356bcfFd9292basf!
m Ethernet Loopback Tests Processor Functional Test
-> @:100 | resp
m Program MMC via Ethernet T [y S
# Edit €2 Copy Done.
» Run >_ Rename Processor Fast Done!
© Delete Programming
Reports
= Requirements 0 e
o Processor Fast fun tine
m Program MMC via JTAG -
Proarammina
ScanWorks'

Platform for Software Debug and T
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Quick Start Guide | Using PFx on an i.MX6 SabreLite

28. Right click on Program MMC via JTAG to open the Development interface for the
Program MMC via JTAG action.

(=] = E

@ VTOS Developer™ [3.0.14.5] (Program MMC via JTAG)

File Tools View Licensing Help
(= |
Welcome! NECT PN TFTP FLASH
FProject Settings | Console
=[] Project:Program MMG via JTAG 4 General
& Connection Setings Name Program MMC via JTAG
23 Fixure:[1] N iMX6 i
® <Add Fixture> o v
L % Tasks Stop On Failure True
#) Task:VTOS Program MMC Normalize Files True
@ <Add Task> 4 Target
Load Firmware on Connect False
Issue Target Version False
Issue Reset on Disconnect False
4 VTOS Runner
Task Logging Option Append
5% Configuration [VTOS Program MMC] Use Timestamps False ;
g Run Option Stop on Failure
[ Board Initialization Run Delay (ms) 0
g ;‘C"”Cf’i"“gu'a““" Loop Option Loop Once
" Loap Stop Candition 1

£ Processor [IMX6Q]
(=< SD/MMC/SDIO Group
~ uSDHC1

P Tom Name
® Program From File

® Image Checksum Test Name of the selected item
@ <Add Operation>

14 Fuse Operations

[ copy J[ peete |[ up ][ pown |

Project: C:A\ScanWorks\Projects\SABRElite_Example_Project\SABRE MMC via JT/ gram MMC via JT/ 1 MMC via JTAG project (iMX6iMX6Q) [VTOS Prod [ SN

29. This action tests for the presence of the SD/MMC card, erases a portion, performs a
blank check on the portion, programs the SD/MMC card with a file using JTAG as the
data pipe, and runs a checksum on the portion programmed. Click on Connect and

Run.

] b= B

Help

VTOS Developer™ [3.0.14.5] (Program MMC via JTAG)

File Tools View Licensing

=] e ‘

Done CONNECT PN TFTP FLASH

Project Settings | Console

=[] Project-Program MMC via JTAG
&) Connection Setings

ProgranC Firmvare

'O Firture:{1]
® <Add Fixture> 03.082 (2018.05)
S% Tasks 2018-05-03 at 17:26:26
() Task:VTOS Program MMC anvior! AB] roject\SABRELi te\Program MIC via JTAG\Program MMC via JTAG\sabrelite imx
- t\SABREL te\Progran MIC via JTAG\Program MMC via JTAG elite

® <Add Task>

ot // SDM width=a)
* 3 sammoc.install drop // SD/MMC Install(SDMMC

Task
=% Configuration [VTOS Program MMC] x0000000000000000: 64 2 -unprotected. test // Image Unprotected Test(SDMMC 4:1)
B otected/unlocked verify t
[ Board nitislization
[ Pin Configuration
B0 Scripts 2 4 0x0000000000100000 ¢ .erase.test // Image Erase Test(SDMMC 4:
= Processor [iMX6Q]
£+</ SDIMMC/SDIO Group
B uSDHCT
- uSDHC2 D x 4 0x000000000010000 blank.test // Image Blank Test (SDMMC 4:
&

Dl cankorks\Projec RELite_Example_Project\SABRELite\Program MC via JTAG\Program 1

® <Add Device>
£ 4 Program Operations
® Image Unprotected Test

Program device from

programming file 'C:\ScanWorks\Projects\SABRELite Example_Project\SABRELite\Program MIC via JTAG\Program MIC vi

N

buffering t; double
Programmed 0x00000000_00100000 bytes, in 8.977 370 073 seconds, throughput of 114.06
[BASSED]

Image Erase Test
Image Blank Test
Program From File
Image Checksum Test

@ <Add Operation>
19 Fuse Operations s' spus <0000000005000000: 64 0xD000D0000D100000:64 s' aa26EESHBIS35EbaLEA9292DAOLES TRUE image6.md5.test // Image
D rify Test:

Tt offset 0xD 0xB000000, byte count 0x0 0xL000OD
356 basfese6s

[ copy J[ peete |[ up ][ pown |

Project: C\ScanWorks\Projects\SABRElite_Example_Project\SABRE MMC via JT/ gram MMC via JT/ 1 MMC via JTAG project (iMX61MX6Q) [VTOS Pro( [EPTESET

ScanWorks’
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Quick Start Guide | Using PFx on an i.MX6 SabreLite

30. Note that in the example above, the SD/MMC card was programmed at a rate of 114
KiB/second. Close the Development interface, and click on the Run button to the left of
Program MMC via JTAG.

- — - )
% ScanWorks: SABRElite_Example_Project SABREIite (=] =] s

Project: SABRElite_Example_Project # RIC-1000 = options | & Licenses | ?Help |[C1EH]

Design: SABRElite TCK Frequency: 30.000 MHz
IP Address: 192.168.12.119

Compatible with Design? ves
Projects Designs Actions Sequences Status Notes Mappings Reports Pa Ssed

SYe -l | & Manage & Build - ughput of 114.451 KiB/s .
> @:108 | resp-'’
Search: [Find Actions -> Test passed; status-100
S* SDMMC 4:1° 164 100000:64 ' 2226FF5
. - 5 o
Action Name Type bB95356DCFFd9292bagf89e66" TRUE image6d.mds.test // Image Checksum Tes

T(SDMMC 4:1)

m DDR RAM Test Processor Functional Test SDMMC 4:1: MDSSUM Verify Test: start offset Ox@ 8x3088888, byte count 8
DDR X8 x100800
m Device Presence Tests Processor Functional Test Device="SDMMC 4:1' md5=aa26ff5b895356bcffd9292baaf89e66
m Ethernet Loopback Tests Processor Functional Test
-> 0:100 | resp-'’
. Processor Fast
m Program MMC via Ethernet ) -> Test passed; status=10@
Programming B
m Program MMC via JTAG Done!
E Acti d!
# Edit (2] Copy ction passer
» Run >_ Rename Processor Fast
© Delete Programming T
Run time: 16.365
[u Reports.
= Reauirements e -
ScanWorks*

L)

31. Right click on the Program SPI Flash via Ethernet to open the Development interface
for the programming action.

@ VTOS Developer™ [3.0.14.5] (Program SPI Flash via Etheret) . & = El ]
File Tools View Licensing Help
[ eas ][ come fun || oscomet \
‘ Welcome! CONNECT PIN TFIP FLASH | ‘

[Project Setings |console

ject:Program SPI Flash via Ethemet 4 General

Connection Setings Name Program SPI Flash via Ethernet
S e it
<Add Fidure>
% Tasks Stop On Failure True
[2) Task VTOS Program SPI Ethernet Normalize Files True
@ <Add Task> 4 Target
Load Firmware on Connect False
Issue Target Version False
Issue Reset on Disconnect False

4 VTOS Runner

Task Logging Option Append

Fal
(=% Configuration [VT0S Program SPI Ethemet] Use Timestamps lse
@ Board Run Option Stop on Failure
[ Board nitalization Run Delay (ms) 0
[ Pin Configuration Loop Option Loop Once

= Scripts

Processor [iMX6Q] Loop Step Condition 1

</ SPIGroup

== ECSPIT

® SPIFlash:SPIFlash 1:1
<Add Device>

ECSPR

ECSPI3

- ECSPH

~ ECSPI5

1 TFTP Server

& Program Operations
® Image Unprotected Test
& e e Name o theselecte tem
@ Program From File Using TFTP
® Image Checksum Test
@ <Add Opersiion>

@ Fuse Operations

Project: CASc j BRElite_Example_Project gram SPI Flash via gram SPI Flash via Ethemet\Program SPI Flash via Ethernetproject (iMX6

SourcePoint O ScanWorks’
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32. Inthis action, the SPI Flash is tested for presence, the Flash is tested to see if it is
protected (locked), the Flash is erased, a blank check is run on the flash, the flash is
programmed with data over the Ethernet port and the checksum test is run. Configure
the TFTP Server setting the same as in Program MMC via Ethernet. Click on Connect
and then Run.

@ VT0S Developer™ [3014.2] (6) PFP3) ==X

File Tools View Licensing Help

‘\ add | e Run || Disconnect ‘

Done CONNECT PIN TFIP FLASH

Project Settings | Console

=[] Project:6) PFP3. -
1@ Connection Setings SFL256SAGNFI00' 0x000000000000000 0x0000000000100000 356b0EEad: TRUE image64.mds. test /)|
'O Firture:{1] 256SAGNFI00: MDSSUM Verify T feset 0x0 0x0, b 100000
® <Add Fixture> AGNFI00' md5-aa26££5h 6b
=% Tasks

2] Task VTOS Program SPI MMC

x : x :6 264, ¢ e Erase Test (SDMMC 1:
& <Add Task> 000000080000000:64 0x0000000000100000:64 image64. er: // Image Erase Test(SDIEC 1:1)

000000080000000:64 0x0000000000100000:64 image64.blank.test // Image Blank Test (SDMMC 1:1)

Task
X0000000080000000:64 §' C:\ScanWorks\Projects\Zedboard Example_Project\Zedboard\6) PFP3\6) PFP3\Imb.test' 0x00(
=% Configuration [VT OS Program SPIMMC] - e from file test - -
=l Board
[ Board Inialization e: programming file 'C:\ScanWorks\Projects\Zedboard Example Project\Zedboard\6) PFP3\6) PEP3\lmb. , offset {
[ Pin Configuration a
G Scipts 0000_00100000 by seconds, throughput of 90.280 KiB/s
= Processor [2-7020] -
£<! SPIGroup
B SPI : 0000000800000 x0000000000100000
B SPIT Verify T t offset 0x0 Ox
= QsPl . ' 53
® SPI Flash:S25FL256SAGNFI00
® <Add Device>
£< SDIMMC/SDIO Group 1 000000050000000: 64 0x0000000000100000: 64 inage6d st // Image Erase Test (SDMMC 1:1)
- SDMMCD =
® SD/MMC:SDMMC 1:1 L
@ <Add Device> 3
- SDMMCT ' 0x0000000080000000:64 0x0000000000100000:64 image6d.blank.test // Image Blank Test (SDMMC 1:1)
&4 Program Operations
Image Erase Test:SPI Flash
Image Blank Test:SPI Flash
Program From File:SPI Flash
Image Checksum Test:SPI Flash
Image Erase Test:SD Card
Image Blank Test:SD Card
Program From File:SD Card ed 0x 907 seconds, throughput of 671.958 KiB/s
Image Checksum Test:SD Card *
Image Erase Test:QSPlto MMC -
Image Blank Test:QSPIto MMC <[« I »
[ copy J[ peete |[ up ][ pown |
Project: CAScanWorks\Projects\Zedboard_Example_Project\Zedboard\6) PFP3\6) PFP3\6) PFP3.project (Zynq-7000 Z-7020) [VTOS Program SPIMMC] Elapsed: 000 I

33. In the example above, the flash on the SPI is programmed over JTAG at a rate of 4.375
KiB/second. Close the Development interface. Click on the Run button to the left of

Program SPI Flash via Ethernet to program the flash as a ScanWorks action.
& ScanWorks: SABRElite_Example_Project. SABRElite @ [

Project: SABRElite_Example_Project # RIC-1000 Options | & Licenses || ? Help

Desig n: SABRElite TCK Frequency: 30.000 MHz
1P Address: 192.168.12.119
Compatible with Design? VYes

Projects Designs Actions Sequences Status Notes Mappings Reports

onds, throughput of 4.380 KiB/s N

P2 Manage & Build

> 0:100 | resp=""

Search: -> Test passed; status
s' SPI Flash 1:1' 64 64 s 9fc

Action Name “ Type de118bba739e1befaec3deeasact7’ TRUE image6s.nds.test // Image Checksun

Test(SPI Flash 1:1)
m DDR RAM Test Processor Functional Test SPI Flash 1:1: MDSSUM Verify Test: start offset xo @x0, byte count exe
DDR ex2800
m Device Presence Tests Processor Functional Test Device='SPI Flash 1:1' mdS=9fcdel18bba739elbefaec3d6eadacts
m Ethernet Loopback Tests Processor Functional Test

@:100 | resp=""

m Program MMC via Ethernet Processor Fast -> Test passed; status=108
Programming

mpwoglan MMC via JTAG Processor Fast Done!
Programming

m Program SPI Flash via Ethernet
& Edit ] Copy

» Run >_ Rename
N ST Proarammina

Run time: 32.012
Processor Fast e

ScanWorks®

O ScanWorks®
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34. Right click on the Program SPI Flash via JTAG to open the Development interface for
the programming action.

@ VTOS Developer™ [3.0.14.5] (Program SPI Flash via JTAG) ‘

S

File Tools View Licensing Help
[ saa ] [Ccomea | ‘
Welcome! ONNECT PIN
[Project Settings | Console
=[] Project-Program SPIFlash via JTAG 4 General
7@ Connection Setings Name Program SPI Flash via JTAG
-3 Fixture:[1] 5 MG i
@ <Add Fixture> ocesso y
S Tasks Stop On Failure True
2] Task-VTOS Program SPI Normalize Files True
@ <Add Task> 4 Target
Load Firmware on Connect False
Issue Target Version False
Issue Reset on Disconnect False
4 VTOS Runner
Task Logging Option Append
5% Configuration [VTOS Program SPI] Use Timestamps False ;
B Run Option Stop on Failure
[ Board Initialization Run Delay (ms) 0
& g ;‘C"”gi"“gu'a““" Loop Option Loop Once
£ Processor [IMX6Q] Loop Stop Condition 1
£ SPIGroup
B ECSPI

SPIFlash:SPIFlash 1:1
® <Add Device>

G ECSPR2

5 ECSPI3

5 ECSPM

& ECSPI5
&4 Program Operations

® Image Unprotected Test
Image Erase Test
Image Blank Test
Program From File
@ Image Checksum Test
® <Add Operation>
i) 4 Fuse Operations

Name
Name of the selected item

[ copy J[ peete |[ up ][ pown |

Project: C:\ScanWorks\Projects\SABRElite_Example_Project\SABRE SPI Flash via JTAG\Program SPI Flash via JT SPI Flash via JTAG project (iMX6 iMX6Q) [ [EF SR N

35. This action tests the SPI Flash for presence, checks to se if the flash is writable, erases
the flash, blank checks the flash, programs a test file into the flash over JTAG, and tests
the checksum. Click on Connect, and then Run.

@ VTOS Developer™ [3.0.145] (Program SPL Flash via JTAG) = EE )

File Tools View Licensing

Help

‘ add Run | [ pisconnect ‘

Done CONNECT PIN TFTP FLASH

Project Settings | Console

=% Project:Program SPIFlash via JTAG
& Connection Settings IDUT ready
3 Firture:[T] VTOS iMX6 ErogramSEI Firmware
® <Add Fixture>
=% Tasks
£ Task:VTOS Program SPI
® <Add Task>

\ScanWorks\Pr ABRE1ite_Example Project\SABRELite\Program SPI Flash via JTAG\Program SPI Flash via JTAG\sabreli
Include C:\ScanWorks\Projects\SABRELite Example Project\SABRELite\Program SPI Flash via JTAG\Program SPI Flash via JTAG\sabrelit]
e

sh 1:1' 0 1 -1 -1 50000000 25000000 © 0000001 5 3000 serial_flash.concigare // SPT E|
Serial (SPI) NOR Flash Discovery T:
[PASSED]
Task s' SPI Flash 1:1' 0x0000000000000000:64 0x0000000000100000:64 image6d.unprotected.test // Inage Unprotected Test(SPI Flash 1:1)
5 % Configuraion [VTOS Program SPI] ice unprotected/unlocked verify te

oart
[ Board niialization
[ Pin Configuration
. Scripts
Processor [1MX6Q]

0x0000000000100000: 64 image64.blank.test // Image Blank Test(SPI Plash 1:1)

® <Add Device>
~ ECSPI2
~ ECSPI3
~ ECSPH.
~ ECSPI5
=} # Program Operations Brogram to File: programming file 'C

EEEE

) Image Unprotected Test buffering t double
) Image Erase Test Programmed DxD0DODODD_00020000 66 703 seconds, throughput of 4.1

) Image Blank Test [PASSED] -

) Image Ghecksum Test 3 0x000000000002000
@ <Add Operation> 3 :1: MD5SUM Verify Test: start offset 0x0 0xO,
-4 Fuse Operations 1:1' mds 73belcBe65EE15deba69es2ds

| copy |[ Deete || up || Down |

Project: C:\ScanWorks\Projects\SABRElite_Example_Project\SABREIite\Program SPI Flash via JTAG\Program SPI Flash via JTAG\Program SPI Flash via JTAG.project (i.MX6 iMX6Q) [|ElE s E:k R REE R AN

ScanWorks’
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36. In the example above, the flash on the SPI is programmed over JTAG at a rate of 4.164
KiB/second. Close the Development interface. Click on the Run button to the left of Program
SPI Flash via JTAG to program the flash as a ScanWorks action. This concludes the
development portion of this guide.

r = == ﬂ‘
& ScanWorks: SABRElite_Example_Project.SABRElite = =) (5}

Project: SABRElite_Example_Project # RIC-1000 =k Options | & Licenses | 2Help |[CI=14)

Design: SABRElite TCK Frequency: 30.000 MHz
IP Address: 192.168.12.119

Compatible with Design? ves I
Projects Designs Actions Sequences Status Nates Mappings Reports Pa S S e d

# Manage | 2 Build oughput of 4.172 KiB/s o

> ©:100 | resp=""

Search: |Find Actions -> Test passed; status-109
s' SPI Flash 1:1° 164 :64 s* fob
Action Name “ Type 7573belcge65ff15debd69ed2dsed” TRUE imagesa.nds.test // Image Checksum
Test(SPI Flash 1:1)
m DDR RAM Test Processor Functional Test SPT Flash 1:1: MDSSUM Verify Test: start offset @xe exe, byte count exe@
DDR ©x20000
m Device Presence Tests Processor Functional Test Device-'SPI Flash 1:1' md5-fob7573belc8e65ff15deba6oes2dsed
m Ethernet Loopback Tests Processor Functional Test

-» @:1e8 | resp=""

Processor Fast
m Program MMC via Ethernet -» Test passed; status-10@

Programming

Done.

m Program MMC via JTAG Processor Fast Done!
Programming Action passed!
P Fast

m Program SPI Flash via Ethernet rocessorkas
Programming B

B Proaram SPi Flash via JTAG Run time: 43.181

ScanWorks®
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Putting it all together — Manufacturing Mode

When all the development is complete and it is time to use PFx on a manufacturing line, it is

desired to run all the actions with a single click. The mechanism for doing this is Sequencing. To

run all the actions as a sequence:

1. In ScanWorks, click on the Sequences tab.

A ScanWorks: SABREite_Example_ProjectSABRElite |||

l] [ B |

Project: SABRElite_Example_Project
Design: SABRElite

© Auo-rete

Projects  Designs  Actions  Sequences

# RIC-1000
TCK Frequency: 30.000 MHz
1P Address: 192.168.12.119
Compatible with Design? ves

Status  Notes  Reports

PYERS ScanWorks loaded
#** License Check Out ***
Checked out: PFPT_ARM_ML_SUB
Checked out: PFP_32ARM_DLSUB
Checked out: PFT_32ARM_DLSUB
Checked out: PFT_DDR_32ARM_DLSUB

Project SABRElite_Example_Project loaded
Loading SABRElite. Please wait..
Loading of design SABRElite complete

3L Options G licenses  ?Help RlES

ScanWorks

2. Click on the Auto-Create button.

- = ==
& ScanWorks: SABRElite_Example_Project. SABRElite

=) =] )

Project: SABRElite_Example_Project
Design: SABRElite

All_Actions v

Projects Designs Actions Sequences

VNl ¢ Edit  /# Manage # Precondition .
Project Design Sequence

# RIC-1000 = Options
TCK Frequency: 30.000 MHz
1P Address: 192.168.12.119
Compatible with Design? ves

Status Notes Reports

@Help

# [edit notes]

Mapping  Serial Number Status
@ Default | | Enter Serial Number
Enable
Rows Sequence Steps Status
SPVL
Program MMC via Ethernet
Program MMC via JTAG
Program SPI Flash via Ethernet
Program SPI Flash via JTAG
{m—)

& Licenses | 2 Help [(0)=4 ‘

ScanWorks"

SourcePoint’
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Hitting the Run button causes all the actions to be executed.

r — B q
A ScanWorks: SABRElite_Example_Project SABREIite o] =] s

A subdialog may be active: Closing that dialog will return you to main display.

Status Notes Reports

Mapping  Serial Number Status SPV1 running...
Program MMC via Ethernet running...

Program MMC via JTAG running...

¥ Default | Enter Serial Number

Enable
Rows Sequence Steps Status

SPV1

Program MMC via Ethernet

Program MMC via JTAG
Program SPI Flash via Ethernet
Program SPI Flash via JTAG
DDR RAM Test

Device Presence Tests

Ethernet Loopback Tests

Showing 1 to 8 of 8 entries

ScanWorks®
—
(@i bampe roecrerecEE =] =[5 |
. . ) = Opti : 2
Project: SABRElite_ Example Project £ RIC-1000 = Options | & Licenses | ? Help
Design: SABRElite TCK Frequency: 30.000 MHz

1P Address: 192.168.12.119

Compatible with Design? yes
Projects Designs Actions Sequences Status Notes Reports Ssed

# Edit | #Manage & Precondition B Besiuplezion St l =
Mapping Name: leg DLLEEH A TH BT, Serial Number]
Test Name Iteration Log(s) Result
Mapping Serial Number Status
¥ Default | Enter Serial Number Program MMC via Ethernet 1 apply121.log Passed
Program MMC via JTAG 1 apply131.log
Enable
Rows Sequence Steps Status
Program SPI Flash via 1 applyl4llog
SPv1 Ethernet
Program MMC via Ethernet
9 ~ Program SPI Flash via JTAG 1 apply151.log Passed
Program MMC via JTAG |
Program SPI Flash via Ethernet
DDR RAM Test 1 ly161.1
Program SPI Flash via JTAG e :)p v el
- 2 -

ScanWorks®

This concludes the Manufacturing portion of the guide.
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Learn More

If you are interested in our products, please select one of the links below:

ScanWorks Processor-based Flash Programming (PFP) for ARM 32-bit

Processors

ScanWorks Processor-based Functional Test (PFT) for ARM 32-bit

Processors

ScanWorks Processor-based Functional Test DDR (PDTDDR) for ARM

32-bit Processors

SourcePoint ScanWorks®

Platform for Software Debug and Trace Platform for Embedded Instruments



http://go.pardot.com/l/7432/2018-06-08/6x336w
http://go.pardot.com/l/7432/2018-06-08/6x336w
https://www.asset-intertech.com/products/scanworks-board-functional-test-device-programming#769
https://www.asset-intertech.com/products/scanworks-board-functional-test-device-programming#769
http://go.pardot.com/l/7432/2018-06-08/6x3371
http://go.pardot.com/l/7432/2018-06-08/6x3371
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